
HELP - Demo
1 - Month Trial $49.00

To Order or For Additional Information Call!
1 - 800 - 251 - FUND(3863)
Compuserve Address:74352.3530
America On-line:jacobma
E-mail:74352.3530@compuserve.com
Internet:jacobma@netcom.com

Click on desired text for help

 ONLINE BOOK:                
                    TABLE OF CONTENTS (demo only covers ch3&4) 

FUNDS COVERED (900 +)

ORDERING INFORMATION 



Only chapters 3 and 4 are included to give you a feel for the program.
Complete product includes a 18 chapter manual on-line.

CHAPTER 1 - 2 EXCLUDED IN DEMO

CHAPTER 3        FUNDAMENTALS
CHAPTER 4        TUTORIAL

CHAPTER 5 - 18 EXCLUDED IN DEMO

          Click here for breakdown of sections



CHAPTER 1 - 2 EXCLUDED IN DEMO

CHAPTER 3    FUNDAMENTALS
          3.1    STARTING OUT
          3.2    TOOL BAR
          3.3    DRAW BAR
          3.4    STATUS BAR 
          3.5    FUND GROUPS 
          3.6    CURRENT FUND                     
          3.7    ACTIVE INDICATOR WINDOW
CHAPTER 4 TUTORIAL
          4.1    OPENING A FUND GROUP
          4.2    GROUP WINDOW OVERVIEW
          4.3    SELECTING AN INDICATOR

                    4.3.1    EDITING INDICATOR PARAMETERS - MAIN
                    4.3.2    EDITING INDICATOR PARAMETERS - STATISTICS
                    4.3.3    SELECTING AN INDICATOR
          4.4    TIMING INDICATORS
          4.5    DRAWING FUNCTIONS
          4.6    FUND DESCRIPTION
          4.7    LOAD INDIVIDUAL FUND
          4.8    STATISTIC GROUPS
                    4.8.1    CREATING STATISTIC GROUPS
                    4.8.2    STATISTICS WINDOW
          4.9    WINDOWING COMMANDS
          4.10    FUNDPRO DOWNLOADER - not included for use in demo
          4.11    LATEST PRICING
          4.12    CONCLUSION         

CHAPTER 5 - 18 EXCLUDED IN DEMO



1 - Month Trial $49.00

To Order or For Additional Information Call!
1 - 800 - 251 - FUND(3863)
Compuserve Address:74352.3530
America On-line:jacobma
E-mail:74352.3530@compuserve.com
Internet:jacobma@netcom.com

MANHATTAN ANALYTICS, INC.
912 Manhattan Avenue, 2nd Floor
Manhattan Beach, CA 90266



Chapter 3.Fundamentals
Do Not Skip This Section

3.1    Starting Out
When you begin FundPro, the following screen will be displayed.    

Note:    If the Autoload feature was previously selected from the fund groups dialog box, a fund group will be 
loaded on startup and a    mutual fund's price history will be displayed.

There are three icon bars which simplify access to the most commonly used features of FundPro:

1.          Tool Bar - Provides access to the primary functionality of the program 
                including the various statistics, indicators, and windowing commands.
2.          Draw Bar - Provides access to the various drawing commands
                including Trendlines and Fibonacci Arcs.
3.          Status Bar - Displays helpful information in its different windows and

                allows for selection of the Current Fund.

Note: If there are no fund groups open, there are only four options available: Fund Groups, Downloader, 
Help, Exit.



3.2    Tool Bar
The Tool Bar provides push button access to the major functionality of FundPro.    It is located near the top of the 
program window and can be toggled On or Off from the Windows menu.

The Tool Bar is composed of the following items in the order of their appearance from left to right.

 
1.          Fund Groups Icon:    Allows you to open, add, delete, and edit a fund
                group.
2.          Indicators Icon:    Allows you to select and edit indicators for the active

                fund group.
3.          Statistic Groups Icon: Allows you to open, add, delete, and edit a 
                statistic group.
4.          Fund Portfolios Icon: Allows you to open, add, delete, and edit a
                fund portfolio for the active fund group.
5.          Load Individual Fund Icon:    Allows you to display any fund from the
                FundPro database.
6.          Fund Description Icon:    Displays a brief description of the Current
                Fund.
7.          Latest Pricing Icon:    Displays the most current day’s pricing for the
                funds in the active fund group. 

8.          Tile Fund Groups Icon: Tiles the fund group windows to fill the available
                area of FundPro.
9.          Cascade Fund Groups Icon: Cascades the fund group windows within the
                available area of FundPro.
10.      Tile Child Windows Icon:    Tiles the child windows to fill the active fund 
                group window.
11.      Stack Child Windows Icon:    Stacks the child windows vertically to fill the

                active fund group window.
12.      Cascade Child Windows Icon:    Cascades the child windows within the active
                fund group window.



    

 
13.            Align Dates Icon: Sets the period displayed for all indicator windows
                      within a fund group window to the period of the active indicator 
                      window.
14.            Zoom In Icon:    Allows you to zoom-in on a specific period within the
                      active indicator window.
15.            Zoom Out Last Icon:    Allows you to zoom back to the previous period if 
                      one was defined, otherwise the entire loaded history will be displayed. 

16.            Print Icon:    Enables you to print any window of the active fund group.
17.            FundPro Downloader Icon:    Starts the FundPro Downloader where you
                      can update your database and transmit messages to and from Manhattan 
                      Analytics.
18.            Help Icon:    Opens the on-line Help file.



3.3    Draw Bar
The Draw Bar provides push button access to the drawing functions of FundPro.    It is located on the left edge of 
the program window and can be toggled On or Off from the Windows menu.

The Draw Bar is composed of the following commands in the order of their appearance from top to bottom.

 ERASE    

 TRENDLINE

 EXTENDED TREND LINE

    VERTICAL LINE

 HORIZONTAL LINE

 INTERSECTING LINES

 PITCHFORK

 CYCLE LINES

 FIBONACCI FANS

 FIBONACCI ARCS

 FIBONACCI TIME ZONES

 TEXT

Note: The text icon is not displayed on monitors with a resolution less than 800 x 600.



3.4    Status Bar
The Status Bar displays information to assist you in the use of FundPro.    It is located on the bottom of the program 
window and can be toggled On or Off from the Windows menu.

The Status Bar is composed of the following items in the order of their appearance from left to right.

1.          Icon Information Window - Displays the name of the icon over which
                the mouse is positioned.    This allows you to quickly determine the

                function of an icon by positioning the cursor over it.
2.          Drawing Function Information Window - Displays the status of the
                selected drawing function.    For example, when the Fibonacci Arc
                function is chosen, you are prompted to "Select First Point."
3.          Previous Fund Icon - Sets the Current Fund to the previous fund in the
                fund group.
4.          Select Current Fund Icon - Allows you to directly select the Current Fund
                from the funds in the fund group.
5.          Next Fund Icon - Sets the Current Fund to the next fund in the fund group.
6.          Symbol Window - Displays the symbol of the Current Fund.
7.          Fund Name Window - Displays the name of the Current Fund.



3.5    Fund Groups
FundPro is designed around the concept of fund groups.    Nearly all aspects of the program revolve around the fund 
group.    Understanding this concept is fundamental to effectively using FundPro.    

A fund group is comprised of the following:

*            Name - The name of the fund group which is located
                on the fund group window title bar.
*            Set of funds - The mutual funds to be analyzed.

*            Benchmark - A fund or index against which the funds
                in the group are compared.    The Benchmark is located
                following the fund group name on the fund group window 
                title bar.
*            Period - The length of time the funds in the group are
                to be loaded.

Note: A fund group must be opened before any analysis can be performed.

A fund group contains a set of funds with a defined Benchmark.    The funds in the group are selected from the 
FundPro database. The Benchmark for the group is a fund or index against which the funds in the group are 
compared.    For example, to analyze the funds in the group against the market, you can select a mutual fund that 
approximates the market to be the Benchmark, like Fidelity's US Equity, FUSEX.    Remember, for your data to 
have meaning, choose a suitable benchmark.

Note: To aid in your analysis of mutual funds, FundPro also tracks many accepted market indexes, such as the 
S&P 500.    FundPro allows you to select any fund or index in the database to serve as the Benchmark.    One word
of caution when using true indexes as benchmarks: investing in an index is not comparable to investing in a 
mutual fund.

FundPro comes with fund groups for over 150 of the most popular mutual fund families.    For example, the 
Fidelity Investments group contains over 100 Fidelity Mutual Funds.    Additionally, FundPro includes fund groups 
for over 20 investment objectives, such as Aggressive Growth and Income.

Note: Multiple fund group can be open simultaneously.



To open a fund group:

1.          Choose Fund Groups from the Tool Bar or the File menu.    

                A dialog box will be displayed listing the available fund groups.    

2.          Select a fund group from the list.
3.          Click on Ok.    
                This will create a fund group window and load the funds in the group. 
                A Price History indicator will be opened displaying the performance
                of the Current Fund versus the Benchmark.

The name of the fund group and the Benchmark are displayed on the title bar of the fund group window while the 
name and symbol of the Current Fund are displayed on the Status Bar.    Once a fund group is loaded, analysis can 
be performed on the funds within the group.



3.6    Current Fund
The Current Fund is the fund upon which the various indicators (Price History, MACD, etc.) operate.    When a fund
group is opened, the first fund in the group becomes the Current Fund.

For example, assume that the Current Fund is FDCAX (Fidelity Capital Appreciation) and that the Benchmark is 
FMAGX (Fidelity Magellan).    If the Price History chart is displayed, the two items charted are the Current Fund, 
FDCAX, and the Benchmark, FMAGX.



3.7    Active Indicator Window
The active indicator window is the window within the active fund group window that receives commands from the 
icon bars or the menu.    Only an indicator window (Price History, Relative Strength, etc.) can be the Active Window.

The active indicator window is used by:

*          All drawing and zoom functions.
*          The Date Align command.
*          The statistic groups.

The active window is designated by the word "Active" attached to the window title.

Note: For an indicator window to receive inputs it must be designated as "Active" and its fund group window 
must also be active.

To select the active window:

*          Double-click on the area of the desired indicator window.

To select the active fund group window:

*          Click on the area of the desired fund group window.

Note: When a new indicator is displayed, it automatically becomes active.



Chapter 4.    Tutorial
This chapter provides a brief tutorial on FundPro and its possible use. Remember that this tutorial is not a 
recommended investment strategy.    It is merely intended to demonstrate the functionality of FundPro.    
Please review this chapter thoroughly to acquire an overview of the program.

4.1    Opening a Fund Group
To begin our analysis of mutual funds we need to open a fund group.    We will illustrate how this is done by opening
the Fidelity Investments group.

To open a fund group window: 

1.          Choose Fund Groups from the Tool Bar or File menu.

A dialog box will be displayed listing the available fund groups

2.          Highlight Fidelity Investments from the list.
                To aid in your search, type the first few letters of 
                "Fidelity" in the Find edit box. 
3.          Choose OK.
                A window for the fund group will be created.



4.2    Group Window Overview
Within the fund group window, a Price History window will be created displaying the price history of the Current 
Fund and that of the Benchmark.    Any statistics previously selected for the Price History indicator will be displayed
at the bottom of the Price History window.    

Once a fund group window is opened, other windows can be created within it, such as indicator windows (Relative 
Strength, MACD, etc.) and statistic windows (statistic groups, Latest Pricing).    These windows within the fund 
group window are referred to as "child windows" (i.e., children of the fund group window).

The symbol of the Current Fund, FDCAX, will be displayed on the Status Bar while the name of the fund group, 
Fidelity Investments, and the Benchmark, U.S. Equity Index, will be displayed in the title bar of the fund group 
window.

To scroll amongst the funds in the Fidelity Investments group, choose Previous Fund or Next Fund from the Status
Bar or the File menu.    



To select a specific fund from the group:

1.          Choose Select Current Fund from the Status Bar or the File menu.

2.          Highlight the fund in the dialog box which appears.

3.          Choose OK.
                The fund selected will become the Current Fund.



4.3    Selecting An Indicator
FundPro contains many powerful indicators to assist in fund selection and timing.    To illustrate, we will use the 
Relative Strength indicator to determine whether the Current Fund, FDCAX, is outperforming the Benchmark.    The
Relative Strength indicator, as well as all other indicators in FundPro, can be chosen from the Charts menu or from 
the Indicators dialog box accessible from the Indicators icon on the Tool Bar.    For this example, make sure the 
current fund is FDCAX.

4.3.1    Editing Indicator Parameters - Main

Note: Before selecting an indicator for the first time, it is recommended that you edit the indicator's parameters 
to suit your needs.

To edit the Relative Strength indicator:
1.          Choose Indicators from the Tool Bar or Edit Parameters from the 
                Charts menu.

A dialog box will be displayed listing the indicators available.

2.          Select Relative Strength from the list.
3.          Choose Edit.
                A dialog box for the Relative Strenght indicator will be displayed where its
                parameter can be defined.        



From an indicator’s dialog box we can select calculation periods, line colors and statistics.    The Relative Strength 
chart displays three lines: the Relative Strength, a fast moving average of the Relative Strength, and a slow moving 
average of the Relative Strength.    

To define the periods for the Fast Moving Average and the Slow Moving Average, enter new values in the respective
Period text boxes.

As a rule, the greater the period, the greater the smoothing.    Unfortunately, increasing the smoothing also increases 
the lag in the response time to changes in the trend.    For timing indicators (indicators which generate buy/sell 
signals for fund timing), the greater the period, the fewer signals generated.    

For the Relative Strength Indicator, set the Fast Moving Average to 50 days and set the Slow Moving Average to 
200 days.    Fifty days is considered by many investment professionals to approximate the medium term trend, 
while 200 is considered to approximate the long term trend.

Note: All periods are specified in market days.



4.3.2    Editing Indicator Parameter - Statistics

Once we have defined the periods and colors of the Relative Strength Indicator, we will choose the statistics to be 
displayed on the bottom of the indicator window.    All indicators windows may display statistics.

To have statistics displayedin the Relative Strength indicator window:

1.          Check the Display box from the dialog box of the indicator.
                This will display the selected statistics when the indicator window is

                opened.
2.          Select Edit.
                A dialog box will be displayed listing the available statistics for the 
                Relative Strength chart.    For our purposes, we want to display    Alpha, 
                Beta, R-Squared, and Standard Deviation for the Current Fund.    To do
                so, we need to add these statistics to the Selected Statistcs list.    

To add a statistic to the indicator window:

1.          Highlight the desired statistic from the Available Statistics list.
2.          Select Add.    

To delete a statistic from the indicator window:

1.          Highlight the desired statistic from the Selected Statistics list.
2.          Select Delete.    



Once we have selected the statistics to be displayed, select OK.    This will save the statistic changes and return us to
the main dialog box for the Relative Strength Indicator.    Having set the smoothing periods, line colors, and statistics
to be displayed, we are ready to save our changes to the indicator.    To do so, select OK.    The Indicators dialog 
box will once again be displayed.

4.3.3    Selecting an Indicator

Now that we have configured the Relative Strength Indicator to our desired specifications, we can display it.

To display the Relative Strength Indicator:

1.          Highlight Relative Strength from the Indicator list.

2.          Select OK 
                A Relative Strength window will be created within the fund group
                window.



4.4    Timing Indicators
FundPro contains four indicators which are commonly used for mutual fund timing.    They are Momentum, MACD,
Moving Average Crossover, and Relative Strength Crossover. To develop an understanding of the use of timing 
indicators, we will examine a market timing strategy using the MACD Indicator.

To edit and display the MACD Indicator:

1.          Click on the Indicator icon from the toolbar.

                This will display a dialog box of available indicators.

2.          Highlight MACD.
3.          Click on Edit.
                A dialog box will be displayed where we will set the parameters of the
                MACD and choose the statistics to be displayed.



4.          Enter "20" in the Fast Mov Avg text box.
                This will allow us to capture the short term trend.
5.          Enter "50" in the Slow Mov Avg text box.
                This will allow us to capture the medium term trend.
6.          Enter "25" in the Trigger Mov Avg text box.
                This will determine the trigger time period for the MACD.
7.          Check Fund Switching.
                This will generate statistics that reflect switching between the Current 

                Fund and the Benchmark instead of simply trading in and out of the
                Current Fund.
8.          Check Display.
                This will display the selected statistics when the MACD window is opened.
9.          Choose Edit.
                A Statistics dialog box will appear where we will select the statistics to be 
              displayed.



10.          Highlight Return Benchmark from the Available Statistics list.
11.          Select Add.
                    This will add the statistic to the list of those selected to be displayed in
                    the indicator window.
12.          Repeat the last two commands to add the following statistics: Return 
                    Fund and Return Timing.
13.          Select OK in the Statistics dialog box.
                    This will save the statistics chosen.

14.          Select OK in the MACD dialog box.
                    This will save any changes made to the parameters of the MACD.
15.          Select OK in the Indicator selection dialog box.
                    This will open the MACD window with the defined parameters.

Once the parameters have been set for an indicator, they become the new defaults for the indicator.    Therefore, the 
next time you want to display the indicator, simply select it from the Indicators dialog box.



4.5    Drawing Functions
FundPro contains a wealth of drawing tools to aid in your charting analysis.    To illustrate the use of the drawing 
functions, we will draw a trendline.

Note:    All drawing functions are accessible as icons from the Draw Bar on the left-hand side of the program 
window or from the Draw menu.    Drawing functions only operate on the active window.

A trendline is defined by 2 points.    Rising trendlines are usually drawn between two significant lows to determine 
a price support level, while falling trendlines are drawn between two significant highs to determine a    price 
resistance level.    The theory behind trendlines is that a trend will continue until the trendline is violated (i.e., when
the NAV crosses the trendline).    When a breakout from the existing trendline occurs, a trend reversal may be 
imminent.

To draw a trendline:

1.          Choose Trendline from the Draw Bar.

2.          Click and release the mouse at a significant point
                in the active window where you would like to begin 
                the line.
3.          To end the line, click and release the mouse at 
                another significant point.    The completed trendline
                will be drawn at the position selected.

The other drawing functions such as Pitchforks and Fibonacci Arcs are drawn in a similar manner. 



4.6    Fund Description
In addition to examining the price history of a fund and various indicators, FundPro allows you to review 
background information on the Current Fund. FundPro provides a description for every fund in the database to assist
in your mutual fund investing.

Included in the fund description are:

1.            Full Fund Name 
2.            Fund Family
3.            Symbol
4.            Address
5.            Phone Number
6.            Date Established

7.            Maximum Sales Load 
                  Load requirements displayed are the maximums.    Many investment
                  companies offer lower or waive loads for larger investments. Please
                  consult the fund’s prospectus for detailed information.
8.            Objective/Policy
9.            Minimum Initial/Subsequent Investment Requirements
                  The minimum investment requirements are based upon investments
                  mailed directly to the fund company.    IRA investments, money sent via
                  wire, or other means may be subject to different requirements.    Please
                  consult the fund’s prospectus for detailed information.
10.        Distribution History 
 A.    X Dividend Date
 B.    Amount of Distribution
 C.    NAV on Date of Distribution
 D.    Distribution Percentage

Please be aware that the information is updated periodically and may include some commentary as well.    The 
information provided may change without warning.    Therefore, Manhattan Analytics, Inc. recommends acquiring 
a current prospectus before investing in any fund.



To view a description of the Current Fund:

*            Choose the Fund Info icon from the Tool Bar.

A window will be created containing information on the Current Fund.    



4.7    Load Individual Fund
In addition to examining the performance of the Current Fund relative to the Benchmark.    FindPro allows you to 
directly compare one fund against another.    For example, perhaps you would like to compare the performance of 
the Fidelity Select Computer fund, FDCPX, versus the Current Fund.

The Load Individual Fund command allows you to select any fund from the FundPro database and display it on the
same chart with the Current Fund and the Benchmark.    The NAV's of the funds are normalized to make it simple to 
compare the performance of the funds over a specified time period.    

To view FDCPX versus the Current Fund:

1.          Select Load Individual Fund from the Tool Bar or from the
                File menu.    

                The following dialog box will be displayed.



2.          Select FDCPX from the list.
                To ease your search, check the Symbol box and type in the first few
                letters of the fund symbol into the Find box above the list.    
3.          Check the Current Fund box.
                This will select the Current Fund to be displayed in the window along
                with FDCPX. 
4.          Clear the Benchmark box.
                This will prevent the benchmark from being displayed.
5.          Select OK.    

A new indicator window will be created displaying FDCPX against the Current Fund. 

To easily identify the Current Fund line and the new fund line:

*              Select Toggle Legend Window from the Window menu.
                  A legend will be displayed in the upper left-corner of the indicator.



4.8    Statistic Groups
FundPro also gives you the ability to calculate statistics on all of the funds within the active fund group.    Coupled 
with screening and ranking features, you can now easily determine the best performing funds based on your specific 
investment criteria using the numerous available statistics, including those used in Modern Portfolio Theory.    

To calculate statistics for the funds in the group, a statistic group must be defined and selected.    

A Statistic Group is comprised of the following:

*          Name - The name of the Statistic group.
*          Set of statistics - The statistics to be calculated
*          Period - The length of time over which the statistics will be calculated.

FundPro comes with several pre-defined statistic groups. Like fund groups, existing statistic groups can be edited, 
new groups added, and old groups deleted to suit your specific needs. 

 



4.8.1    Creating Statistic Groups

To illustrate the power of FundPro’s statistics groups, we will create and display a new group.

To create a Statistic Group:

1.          Select Statistic Groups from the Tool Bar or the Statistics menu.

 

              This will open a Statistic Group dialog box.

2.          Select Add.
                This will add a new statistic group and display a dialog box where we will

                define the composition of the group.





3.          Enter "Custom Group" in the Name text box.
                This will name the statistic group.
4.          Highlight Alpha from the Available Statistics list.
5.          Choose Add.
                This will add Alpha to the Selected list of chosen statistics.
6.          Repeat the last two commands to add the following statistics: 

Beta, StdDev, R-Squared, and 1 Month Return.
7.          Select 1 Year from the Period list.

                This will define 1 Year as the period over which the statistics like
                Alpha and Beta are calculated.
8.          Select OK.
                This will save the new statistic group.



4.8.2    Statistics Window

Once the statistic group has been defined, select it from the list of groups and choose OK.    The statistics will be 
calculated for each fund in the fund group and displayed in a statistics window.

Within the statistics window, there is a column for each statistic calculated.    Scroll bars are provided to navigate 
through the list. 

Once the statistics are calculated, the list can be ranked (Rank) or screened 
(Scrn) to your specifications.    This is accomplished by selecting the appropriate command in the lower left-hand 
corner of the statistics window.    

Note: The All button refreshes the window to display the complete list if any funds have been screened out with 
the Scrn command.



Statistics Window - Screening

To illustrate the use of the screening feature, we will assume that our investment strategy calls for investing in funds 
with a Beta of less than 1 and a 1 Month Return of greater than 2. 5 %.    We will screen our list of Fidelity funds to 
display only those funds which meet this criteria.

To screen the fund group:

1.          Select Scrn from the Statistics Window.    
                A dialog box will be displayed where we will specify our screening criteria.    

 

2.          Highlight Beta.
3.          Enter "1" in the Less Than [ < ] edit box. 
4.          Select Save Entry.    
                This is required to save each individual entry.    
5.          Highlight 1 Month Return.
6.          Enter "2.5" in the Greater Than [ > ] edit box.    
7.          Select Save Entry.    
8.          Choose OK.    
                The list will be screened to display with only those funds that meet our
                specifications.



Statistics Window -Ranking

FundPro makes it easy to rank the funds on any statistic within the group.    For example, after screening on Beta and
1 Month Return, you may want to know which of the remaining funds have the greatest 1 Month Return. 
Determining this is easy with the Rank feature available from the statistics window.    Any of the columns from the 
statistics window can be used to rank the fund list in either ascending or descending order. 

To rank the fund list:
1.          Select Rank from the statistics window.
                A dialog box will be displayed where we will make our selection.    

2.          Highlight  1 Mnth Return.    
                This will determine the statistic on which to rank the funds.
3.          Select Descending.
                This will determine the order of ranking (Greatest to Least).
4.          Click on OK.
                The list will now be ranked accordingly.

With the funds sorted according to 1 Month Return, we can now easily determine the top preformers for the last 
month.



4.9    Windowing Commands
FundPro harnasses the full power of Windows by allowing you to display multiple windows simultaneously.    As a 
result, all of the opened windows within the active fund group can be moved and sized to your specifications.

To illustrate this feature we will tile the open child windows.

To tile the child windows within the active fund group:

*            Select Tile Child Windows from the Tool Bar or Window menu.
 

    
The child windows will be redrawn to fill the available area of the active fund group.    You can use the Previous and
Next fund commands to scroll amongst the funds in the active fund group.    All open child windows will be updated
to display the Current Fund.





To save the open child windows as a template:

*          Select Save Template from the File Menu.
The open child windows will be saved in their current positions.    You can load the template when opening a fund 
group by selecting Load Template in Fund Groups dialog box.

Note: There can be only one template saved at a time.



4.10    FundPro Downloader - not included for use in demo
If you do not subscribe to FundPro’s Modem Retrieval Service, skip 
this section.

In this selection, we will run through the process of updating your data with the FundPro Downloader.

The FundPro Downloader makes it easy to keep your database current.    Whether you call every day, once a week, 
or once a month, the FundPro Downloader will update your database with data for all of the days you may have 
missed.    Furthermore, all mutual fund data is automatically adjusted for distributions, thus eliminating a common 
problem related to other data sources.

To start the FundPro Downloader:

*          Select FundPro Downloader from the Tool Bar.

            This will call the FundPro Downloader.
            The FundPro Downloader is a separate program used to download the latest 
            data from the Manhattan Analytics, Inc. main database.



4.11 Latest Pricing

Note: Once the mutual fund database has been updated, any open fund group windows must be closed and then
re-opened before the newly downloaded data will be reflected in the analysis.    This is necessary to load the new 
data into memory.

After the Fidelity Investments group has been closed and re-opened to account for the new data, we may display 
the latest prices for the funds in the group.    

To open a statistic window with the latest NAV's:
*          Click on the Latest Pricing icon from the Tool Bar.

              A statistics window will be created listing closing statistics for the funds in
              the active fund group.



Note: Close is the last price available from the database.    Last is the previous price.    Change is the difference
between Close and Last, while %  Change is the percent difference from Last to Close.

As with other statistic windows, the Latest Pricing window can be screened and ranked.    Thus, it is easy to 
determine which funds are up for the day and which were the greatest percentage gainers. 

4.12    Conclusion
The presentation of the main features of FundPro is now complete.    After completing this section you should be 
able to navigate through FundPro.    The remaining sections of the manual present expanded and in-depth analysis 
of each program feature.    We encourage you to experiment with the program and consult the manual or the on-line
Help to get the most out of FundPro.    Best of luck in your mutual fund analysis!



Reminder:    Manhattan Analytics has the ability to add additional funds to the 
database.    Please contact Manhattan Analytics at 1-800-251-FUND(3863) to 
request specific funds.
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SEI Instit.Ltd.Vltility Bnd 
SEI Mngd Trst Eqty-Inc.
SEI Mngd Trst Val. Port.
SEI S&P 500 Index
SEI T/E Trst Int.-Trm Muni
SEI-International
Selected American Shares
Selected Special Shares
Seligman Growth
Seligman Income
Sentinel Common Stock
Short Term Municipal
Sit Nw Bgning Growth 
Sit New Bgning Inc.&Grwth
Sit New Beginning T/F Inc.
Sit Nw Bgning U.S.Gvt Sec.
Skyline Special Equities
SoGen International Fund
Sound Shore
Southeastern Ast Mgmt.Sml-Cp
Southeastern Asset Mgmt.Val
S&P 100 INDEX
S&P 20 TRANSP
S&P 40 UTILITIES
S&P 400 INDUSTRIALS
S&P 500 STOCKS
S&P BANK COMPOSITE
S&P CHEMICALS
S&P HLTH CARE COMP
SteinRoe Capital Opp.
SteinRoe Government Income
SteinRoe High-Yield Muni.
SteinRoe Income Fund
SteinRoe Intermediate Bond
SteinRoe Intermediate Muni.
SteinRoe Managed Muni.
SteinRoe Prime Equities
SteinRoe Special Fund
SteinRoe Stock Fund



SteinRoe Total Return
Stratton Growth
Stratton Monthly Dvdnds
Strong Advantage
Strong Discovery 
Strong Income
Strong Insured Muni Bond
Strong International Stock
Strong Investment
Strong Municipal Bond
Strong Opportunity
Strong Short-Term Bond
Strong Total Return
T. Row Prc Adj.Rate U.S.Govt
T. Rowe Price Cap. Apprec. 
T. Rowe Price Eqty-Inc.
T. Rowe Price Euro Stck
T. Rowe Price Glbl Gvt Bnd
T. Rowe Price GNMA 
T. Rowe Price Grwth & Inc.
T. Rowe Price Growth Stock
T. Rowe Price High-Yield
T. Rowe Price Intrntnl Bond
T. Rowe Price Intrntnl Stck
T. Rowe Price MD T/F Bond
T. Rowe Price Nw Amer.Grwth
T. Rowe Price New Asia
T. Rowe Price New Horizons
T. Rowe Price New Income
T. Rowe Price Sci & Tech.
T. Rowe Price Shrt-Trm Bond
T. Rowe Price Small-Cap Val.
T. Rowe Price Spectrum Grwth
T. Rowe Price Spectrum Inc.
T. Rowe Price Tax-Free Inc.
T. Rowe Price T/F Shrt-Int
T. Rowe Tax-Free High-Yield
Templeton Develop.Mrkts Trst
Templeton Foreign
Templeton Global Opportunity
Templeton Growth
Templeton Income
Templeton Real Estate Sec
Templeton Smaller Cos. Grwth
Templeton World
Twentieth Cent.Blncd Invstrs
Twentieth Cent.Grwth Invstrs
Twentieth Cent.Heritg Invstr
Twentieth Cent.Slct Invstrs
Twentieth Cent.Ultr Invstrs
Twentieth Cent.Vist Invstrs
United Serv. All Amer. Eqty
United Services Euro.Equity
United Serv. Glbl Resources
United Services Gold Shares
United Services Growth



United Services Income
United Services Real Estate
United Services Tax-Free
United Services World Gold
USAA Investment Balanced
USAA Investment Cornerstone
USAA Mutual Income
USAA Mutual Income Stock
Value Line
Value Line Aggress.Inc.Trust
VALUE LINE ARITHMETIC WGHT
Value Line Convertible
Value Line Income
Value Lin Lvgd Grwth Invstrs
Value Line Special Situatns
Value Line T/F Hi-Yld
Value Line U.S. Govt Sec.
Vanguard 500 Fund
Vanguard Asset Allocation 
Vanguard CA Insured L-Trm
Vanguard CA T/F Mny Mrkt
Vanguard Convertible Sec.
Vanguard Equity-Income 
Vanguard Explorer
Vanguard    Int. U.S. Treasury
Vanguard    S/T U.S. Treasury
Vangrd Fxd-Inc. Hi-Yld Corp.
Vangrd Fxd-In.Invst.Grd Corp
Vangrd Fxd-Inc.L-T U.S.Treas.
Vanguard    Short-Term Corp
Vanguard Fixed-Inc. S/T Fed
Vanguard Intrntnl Eqty Euro
Vanguard Intrntnl Eqty Pac.
Vanguard Money Market
Vanguard Money Market-Prime
Vanguard Money Market-Trsry
Vanguard Muni Hi-Yld
Vanguard Muni Insured L-Trm
Vanguard Muni Inter.-Trm
Vanguard Municipal L-Term
Vanguard Municipal Shrt-Term
Vanguard NJ Insrd L-Trm Muni
Vanguard NY insured L-Trm
Vanguard PA T/F fund
Vanguard Preferred Stock 
Vanguard PRIMECAP 
Vanguard Specialized Energy

New funds are continuously being added to our database!
If your fund isn't listed give us a call!

1 - 800 - 251 - FUND(3863)



VERTICAL SCROLL
This allows the user to scroll vertically through the listed information.
 



HORIZONTAL SCROLL
This allows the user to scroll horizontally through the listed information



FIND - window
Gives user ability to locate fund family quickly. This is done by typing in the fund family name.



OK - button
This command proceeds with selected items.



CANCEL - button
This command cancels any adjustments just set.



ADD - button
more info: ADD



DELETE - button
The user can delete a Fund Family by highlighting it and depressing the delete button.



EDIT - button
more info: EDIT



AUTOLOAD - button
The user can select a Fund Group to Autoload. This is done by highlighting a Fund Group and depressing the Save 
Entry -    button. Next, the user depresses on the Autoload - box to set the changes in action.



TYPE - window
There are various types of funds available:
          User Defined
          Fund Families
          Objective



FUND GROUPS - window
Listsing of available Fund Groups to select from.



Icon Information - window
Allows user to determine the function of an icon by placing the (mouse) pointer over the icon.



Drawing Function Information - window
Displays steps for drawing functions.



Previous Fund - button
Steps back to the previous fund in the group.



Select Current Fund - button
Allows the user to select the Current Funf from from the funds in the group.

more info: Select Current Fund



Next Fund - button
Steps to the next fund in the group.



Symbol - window
Displays the symbol of the Current Fund.



Fund Name - window
Displays the name of the Current Fund.



Available Indicators - window:
more info:
Price History
Total Return
Relative Strength
Momentum
MACD
RSI
Stochastic
Moving Average
Mov Avg Crossover
MB Oscillator
Portfolio Performance



EDIT - button
more info: Edit



The user is able to select various on screen colors for Relative Strenght. This is done by clicking on the color box.



Statistics
The user can also calcualate statistics along with there analysis. The statistics are displayeyed allong the bottom of 
the chart.
The user can select to display the statistics by clicking on the display box.

Edit - (Statistics)
more info: Edit



The user is able to select various on screen colors for Fast Mov Avg. This is done by clicking on the color box.
The user is also able to set the number of days in the Fast Moving Averages. This is done by entering the chosen 
number of days in the box.



The user is able to select various on screen colors for    Slow Mov Avg. This is done by clicking on the color box.
The user is also able to set the number of days in the Slow Moving Averages. This is done by entering the chosen 
number of days in the box.



AVAILABLE - window
Statistics available to choose from:
Alpha
Beta
R-Sqrd
StdDev
Rel Vol 
Alpha/sd
Treynor
Sharpe
Rtn Fund
Rtn Bbrk



SELECTED - window
These are the Statistics selected from the Available box to be displayed.



ADD - button
By clicking the Add - button the highlighted statistics in the Available - window are moved to the Selected - 
window.



DELETE-button
By clicking the Delete - button, the highlighted statistics in the Selected - window are deleted.



TYPE - window
There are various types of funds available:
Aggressive Growth
Growth
Growth & Income
Equity Income
Index
International Equity
Precious Metals
Specilized
Balanced
Flexible Portfolio
Gen. Corp Bond (S-M)
Gen. Corp Bond (L)
High Qlty Corp Bond (S-M)
High Qlty Corp Bond (L)
High Yield Corp Bond (Junk)
Gen. Gov Bond (S-M)
Gen. Gov Bond (L)
Mort-Backed Gov Bond
U.S. Treasury Bond (S-M)
U.S. Treasury Bond (L)
International Bond
Municipal Bond (S-M)
Municipal Bond (L)
High Yield
Muni Bond (Junk)
CA Municipal Bond
NY Municipal Bond
State Municipal Bond



TYPE - Window
There are various types of funds available:
          User Defined
          Fund Families
          Objective
          All



FIND GROUPS - window
Gives user ability to locate Fund Group quickly. This is done by typing in the Fund Group name.



SYMBOL - box
Gives user ability to display Symbol. 



These are the available Fund Groups.



The user is able to select various on screen colors for    Individual Fund, Current Fund, and Benchmark. This is 
done by clicking on the color box. The user is also able to choose whether or not to display the Current Fund and 
Benchmark.



Find
Locates a Statistic Group by typing in the name.



The list of available Statistic Groups.



ADD
more info: ADD



DELETE
Deletes highlighted Statistic group in window.



EDIT
more info: EDIT



NAME - window
Displays the Name of User developed statistics.
(The name is editable).



Available-window
These are the statistics available to the user:
Alpha
Beta
R-Sqrd
StdDev
Rel Vol 
Alpha/sd
Treynor
Stanley
Sharpe
Life Rtn
Actv Rtn
1,3,6,9 Mon Rtn
1,2,3,5 Yr Rtn



SELECTED - window
These are the Statistics selected from the Available - box to be displayed.



ADD - button
By clicking the Add - button the highlighted statistics in the Available - window are moved to the Selected - 
window.



DELETE - button
By clicking the Delete - button, the highlighted statistics in the Selected - window are deleted.



PERIOD STAT - window
These are the Periods available to the user:
Lifetime
Active Window
1,3,6,9 Months
1,2,3 Years



RANK - button
more info: Rank



SCRN - button
more info: Screen



ALL - button
more info: ALL



This is some of the data which is available to be viewed. Additional data is available thru the RANK, SCRN, and 
All button.



SCREEN - window
These the parameters by which the user can screen. 



SCREEN - box
This is the item currently being screened.



LESS THAN - box
This allows the user to specify the number less than to screen with.



GREATER THAN - box
This allows the user to specify the number greater than to screen with.



SAVE ENTRY - button
By clicking on the Save Entry - button, the user initiates the values.



These are the items available to rank.



Descending Rank
Rank in reverse order.



Ascending Rank
Rank in forward order.



COMM PORT - window
Select the comm port which the modem is connected.



BAUD RATE - window
Select the baud speed which your modem is capable of.



INITIALAZATION STRING - window
Enter the proper initialization string.



PHONE NUMBER - window
The local calling number to MANHATTAN ANALYTICS, INC. Inc.



PASSWORD - window
This is the user log on password.



This is some of the data which is available to be viewed. Additional data is available thru the RANK, SCRN, and 
All button.



RANK - button
 
more info: RANK



SCRN - button
more info: SCREEN



ALL - button
more info: ALL



GROUP NAME
The Group Name of the currently displayed Funds.



BENCHMARK
The Benchmark is selected by first highlighting the Fund in the Available Fund - window and depressing the 
Benchmark - button.    



FIND - window
Gives user ability to locate a Fund Group quickly. This is done by typing in the Fund Group name.



FIND - window
Gives user ability to locate the Available Funds quickly. This is done by typing in the Available Fund name.



SYMBOL - box
Gives user ability to display Symbol. This is done by clicking on the box.



AVAILABLE FUNDS - window
Listing of Available Funds to select from.



SELECTED FUNDS - window
Listing of Selected Funds to select from.



TYPE - window
There are various types of funds available:
Aggressive Growth
Growth
Growth & Income
Equity Income
Index
International Equity
Precious Metals
Specilized
Balanced
Flexible Portfolio
Gen. Corp Bond (S-M)
Gen. Corp Bond (L)
High Qlty Corp Bond (S-M)
High Qlty Corp Bond (L)
High Yield Corp Bond (Junk)
Gen. Gov Bond (S-M)
Gen. Gov Bond (L)
Mort-Backed Gov Bond
U.S. Treasury Bond (S-M)
U.S. Treasury Bond (L)
International Bond
Municipal Bond (S-M)
Municipal Bond (L)
High Yield
Muni Bond (Junk)
CA Municipal Bond
NY Municipal Bond
State Municipal Bond



TYPE - Window
There are various types of funds available:
          User Defined
          Fund Families
          Objective
          All



PERIOD STAT - window
These are the Periods available to the user:
Lifetime
Active Window
1,3,6,9 Months
1,2,3 Years



ADD - button
By clicking the Add - button the highlighted Fund in the Available - window are moved to the Selected - window.



DELETE - button
By clicking the Delete - button, the highlighted statistics in the Selected - window are deleted.



ADD - button
more info: ADD



DELETE - button
Delete highlighted portfolio.



EDIT - button
more info: EDIT



PRICE
Display Price as vertical scale on chart.



PERCENT RETURN
Display Percent Return as vertical scale on chart.



PORTFOLIO GROUPS - window
These are the current Portfolio Groups listed. The user is also able to add or edit newPortfolios.



The user can change various colors by clicking the colored boxes. The user also has the choice to display the 
Current Fund. This is done by    clicking the Current Fund - box.



Statistics
The user can also calcualate statistics along with their analysis. The statistics are displayed along the bottom of the 
chart.
The user can select to display the statistics by clicking on the display - box.

Edit - (Statistics)
more info: Edit



Find - window
Locates a Portfolio Group by typing in the name.



Name of the portfolio.



Find - window
Locates a Fund by typing in the name.



ADD - button
By clicking the Add - button the highlighted Fund in the Available - window is moved to the Selected -    window.



DELETE - button
By clicking the Delete - button, the highlighted Fund in the Selected - window is deleted.



FUND NAME - window
This diplays the name of the Fund currently highlighted.



Available - window
These are the current funds available to the user.



SELECTED - window
These are the Funds selected from the Available box to be included in the custom portfolio.



WEIGHTING
This is the user definable    weighting. Once the value is entered, the user shoud click on Save Entry - button to 
initiate the changes.



FUND GROUPS - button
more info: FUND GROUPS



STATISTICAL GROUPS -button
more info: STATISTICAL GROUPS



LOAD INDIVIDUAL FUND - button
more info: LOAD INDIVIDUAL FUND



LATEST PRICING - button
more info: LATEST PRICING



SELECT INDICATOR - button
more info: SELECT INDICATOR



PORTFOLIO MANAGER - button
more info: PORTFOLIO MANAGER



FUND INFORMATION - button
more info: FUND INFORMATION



The user can change the color of the FUND and the INDEX    by clicking the colored boxes until the desired color 
is achieved. 



Statistics
The user can also calcualate statistics along with there analysis. The statistics are displayeyed allong the bottom of 
the chart.
The user can select to display the statistics by clicking on the display box.

Edit - (Statistics)
more info: Edit



The user can change the color of the FUND and the INDEX,, by clicking the colored boxes until the desired color 
is achieved.



Statistics
The user can also calcualate statistics along with there analysis. The statistics are displayeyed allong the bottom of 
the chart.
The user can select to display the statistics by clicking on the display box.

Edit - (Statistics)
more info: Edit



The user can change the color of the Fast Moving Average, Slow Moving Average, and the Fund, by clicking the 
colored boxes until the desired color is achieved. The user is also able to specify the Periods of the Fast and Slow 
Moving Averages. This is accomplished by entering their choice of days in the appropriate corresponding boxes.



Statistics
The user can also calcualate statistics along with there analysis. The statistics are displayeyed allong the bottom of 
the chart.
The user can select to display the statistics by clicking on the display box.

Edit - (Statistics)
more info: Edit



The user can change the color of the Fast Moving Average, Slow Moving Average, and the Relative Strength, by 
clicking the colored boxes until the desired color is achieved. The user is also able to specify the Periods of the 
Fast and Slow Moving Averages. This is accomplished by entering their choice of days in the appropriate 
corresponding boxes.



Statistics
The user can also calcualate statistics along with there analysis. The statistics are displayeyed allong the bottom of 
the chart.
The user can select to display the statistics by clicking on the display box.

Edit - (Statistics)
more info: Edit



Statistics
The user can also calcualate statistics along with there analysis. The statistics are displayeyed allong the bottom of 
the chart.
The user can select to display the statistics by clicking on the display box.

Edit - (Statistics)
more info: Edit



The user can change the color of the Stochastic, %K Slowing Period, %D Period (Trigger), by clicking the colored 
boxes until the desired color is achieved. The user is also able to specify the Stochastic, %K Period, %K Slowing 
Period, %D Period (Trigger). This is accomplished by entering their choice of days in the appropriate 
corresponding boxes.



The user can change the color of the Relative Strength Indicator RSI, by clicking the colored boxes until the 
desired color is achieved. The user is also able to specify the Periods of the Period. This is accomplished by 
entering their choice of days in the appropriate corresponding box.



Statistics
The user can also calcualate statistics along with there analysis. The statistics are displayeyed allong the bottom of 
the chart.
The user can select to display the statistics by clicking on the display box.

Edit - (Statistics)
more info: Edit



The user can change the color of the MACD, Fast MA, by clicking the colored boxes until the desired color is 
achieved. The user is also able to specify the Periods of the MACD, Fast MA, Slow Mov AVG and Trigger Moving
Avg. This is accomplished by entering their choice of days in the appropriate corresponding boxes.



Statistics
The user can also calcualate statistics along with there analysis. The statistics are displayeyed allong the bottom of 
the chart.
The user can select to display the statistics by clicking on the display box.

Edit - (Statistics)
more info: Edit



The user can change the color of the Momentum, by clicking the colored boxes until the desired color is achieved. 
The user is also able to specify the Periods of the Period. This is accomplished by entering their choice of days in 
the appropriate corresponding box.



Statistics
The user can also calcualate statistics along with there analysis. The statistics are displayeyed allong the bottom of 
the chart.
The user can select to display the statistics by clicking on the display box.

Edit - (Statistics)
more info: Edit



The user can change the color of the FW Indicator, by clicking the colored boxes until the desired color is 
achieved. The user is also able to specify the Periods of the Fast and Slow Moving Averages. This is accomplished 
by entering their choice of days in the appropriate corresponding boxes.



Statistics
The user can also calcualate statistics along with there analysis. The statistics are displayeyed allong the bottom of 
the chart.
The user can select to display the statistics by clicking on the display box.

Edit - (Statistics)
more info: Edit



The user can change the color of the Mov Avg Crossover, Fast Moving Average, and Slow Moving Average, by 
clicking the colored boxes until the desired color is achieved. The user is also able to specify the Periods of the 
Fast and Slow Moving Averages. This is accomplished by entering their choice of days in the appropriate 
corresponding boxes.



Statistics
The user can also calcualate statistics along with there analysis. The statistics are displayeyed allong the bottom of 
the chart.
The user can select to display the statistics by clicking on the display box.

Edit - (Statistics)
more info: Edit



HEADER
The user can specify a Header to be printer on the chart.



FOOTER
The user can specify a FOOTER to be printer on the chart.



By clicking on the Include Title - box, the user selects to include the title in the printing of the chart.



The highlighted item is designated to be printed.



Refer to Microsoft Windows 3.1 Reference manual additional information.



The user has 16 customizable colors to choose from. The highlighted Color X is displayed in the color box to the 
right.



The color box displays the Color X currently highlighted.



EDIT
more info: EDIT



BASIC COLORS
These are the basic colors available to the user for selecting the base 16 colors.



CUSTOM COLORS
These are the custom colors the user can fill with the 16 colors of their own preference.



DEFINE CUSTOM COLORS
more info: DEFINE CUSTOM COLORS



SUBJECT - window
These are the Subject of the files recieved from MANHATTAN ANALYTICS, INC..



FILE - box
File name of the highlighted subject.



OPEN - button
Open highlighted subject.



DELETE
Delete the highlighted message.



DONE
Exit message window.



TITLE
Tile of message to send.



FILE
The file name.



These are the available file messages to send.



UPDATE - button
Update the current file message to be sent.



ADD
more info: ADD



DELETE
Delete the highlighted file.



BROWSE
Browse thru system for file name.



EDIT
more info: EDIT



AVAILABLE
Statistics available to choose from:
Days Invested
Trades
Profit
Max Gain
Max Loss
Avg Trade
Return Timing 
Return BchMrk
Return Fund



SELECTED
These are the Statistics selected from the Available box to be displayed.



ADD - button
By clicking the Add button the highlighted statistics in the Available window are moved to the selected window.



DELETE-button
By clicking the Delete button, the highlighted statistics in the Selected window are deleted.



EDIT
more info: EDIT



AVAILABLE
Statistics available to choose from:
Days Invested
Trades
Max Gain
Max Loss
Avg Trade
Return Timing 
Return BchMrk
Return Fund



SELECTED
These are the Statistics selected from the Available box to be displayed.



ADD - button
By clicking the Add button the highlighted statistics in the Available window are moved to the selected window.



DELETE-button
By clicking the Delete button, the highlighted statistics in the Selected window are deleted.



FUNDS - window
Listing of    Funds to select from.



FUND NAME
The Fund Name of the currently highlighted symbol.



Find - window
Locates a Fund by typing in the name.



TYPE - window
There are various types of funds available:
Aggressive Growth
Growth
Growth & Income
Equity Income
Index
International Equity
Precious Metals
Specilized
Balanced
Flexible Portfolio
Gen. Corp Bond (S-M)
Gen. Corp Bond (L)
High Qlty Corp Bond (S-M)
High Qlty Corp Bond (L)
High Yield Corp Bond (Junk)
Gen. Gov Bond (S-M)
Gen. Gov Bond (L)
Mort-Backed Gov Bond
U.S. Treasury Bond (S-M)
U.S. Treasury Bond (L)
International Bond
Municipal Bond (S-M)
Municipal Bond (L)
High Yield
Muni Bond (Junk)
CA Municipal Bond
NY Municipal Bond
State Municipal Bond



Regression Interval
This allows the user to specify the parameter of the Regression Interval. 

more info:    Regression Interval



Timing Indicator Delay
This allows the user to specify the parameter of the Timing Indicator Delay. 

more info:    Timing Indicator Delay



Timing Filter (%)
This allows the user to specify the parameter of the Filter (%). 

more info:    Filter (%)



T BILL
This allows the user to specify the parameter of the T BILL.

more info:    T BILL



Subject - window
These are the subjects of the messages being sent.



File - window
This diplays the highlighted message from the above Subject - window.



OPEN - button
Opens the highlighted topic in the Subject - window.    



DELETE - button
Deletes the highlighted topic in the Subject - window.






